Contents

Page 3  Introduction
         What's New in Tiger: The Highlights

Page 5  Working with Fonts in Tiger
         Font Book
         Font Panel
         Character Palette

Page 10  Font Management
          Mac OS X Font Locations
          Classic Fonts and Native Applications
          Server-Based Fonts
          Managing Fonts with Font Book
          Organizing Fonts for a Third-Party Font Manager

Page 22  Optimizing a Production System
          Removing or Deactivating Nonessential Fonts
          Font Management for Prepress and Production

Page 27  Appendix A: Additional Resources

Page 29  Appendix B: Mac OS X Fonts

Page 31  Appendix C: Font Support in Mac OS X

Page 33  Appendix D: Font Locations in Mac OS X

Page 35  Appendix E: International Language Support
Introduction

Whether you’re producing sophisticated type effects for print layouts or selecting an easy-on-the-eyes font for online readers, you know that the effective use of typography is crucial for successful visual communications. Recognizing this fact, Apple has made typography a top priority in every Macintosh operating system from the very beginning. More than any other platform, Mac OS X gives you exceptional creative options for typography and makes your fonts easy to access and manage.

With Mac OS X version 10.4 Tiger, Apple has set a new benchmark for desktop typography. High-fidelity rendering—both onscreen and in print—makes Tiger a visually rich and consistent typography platform. Because it’s built on the Quartz graphic rendering engine, Mac OS X allows you to do more with fonts than ever before. You can manage fonts, create unlimited collections, use any font format, and modify fonts for perfect typography—all with ready-to-use Mac OS X tools. Mac OS X v10.4 also includes more than 100 fonts—28 for different languages—giving you more creative leeway and making it easier to create materials for international consumption.

Advanced typographical capabilities in Mac OS X v10.4 remove the barriers to creativity and give you the freedom to get your job done with exceptional flair and ease.

What’s New in Tiger: The Highlights

When it comes to typography, Tiger has a number of options to help you make your creative vision a reality:

**Virtually no limits.** You can place more than 7000 fonts in the system.

**More fonts.** Mac OS X v10.4 includes more than 100 font families containing 188 typefaces and supports more non-Roman languages and bidirectional fonts than ever before.

**Richer font support.** For more predictable cross-platform and cross-media publishing, Mac OS X supports major font formats, including PostScript Type 1 (with the double-byte PostScript fonts required for non-Roman languages), Multiple Master, Mac TrueType, Windows TrueType, and OpenType.

**Font Book.** The versatile Font Book application, updated in Mac OS X v10.4, finds and manages fonts from a single, central location. Managing fonts in Mac OS X is now as easy as managing songs in iTunes or images in iPhoto.

**Font automation.** Using AppleScript and the new workflow automation tool, Automator, you can automate Font Book and the underlying font system to easily integrate font management into your workflow. By automating actions that you previously had to do manually, Automator simplifies the process of font management.
Font validation. The new validation feature makes it easier to find problems in your fonts by enabling you to identify duplicate, malformed, or corrupt fonts—either before or after you’ve installed them—using the Font Validation pane in Font Book.

Exporting of fonts. The new export feature in Font Book allows you to export properly licensed fonts to a font folder and move them to a different computer to share with another user.

Enabling and disabling of fonts. Font Book now permits the dynamic enabling or disabling of individual fonts or collections of fonts, so you can specify which ones are currently available to applications. This feature is particularly useful if you have many fonts installed, since you can shorten your lists of fonts and choose which versions of font families you want to use at any given time.

Personal font libraries. Tiger now lets you create custom font libraries and specify their location anywhere on your system, such as your project folder, so you can manage the fonts in the file system however you choose while taking advantage of the management capabilities of Font Book. This feature also makes it possible to manage specific fonts that might have otherwise been duplicated in specific jobs.

More comprehensive search. With the new and improved search feature in Font Book using the brand-new Spotlight search technology, you can search by font, PostScript, and family name separately, in addition to searching by attributes or copyright names. You can even search for individual characters in the Character Palette by name—such as family and typeface name.

Smother fonts and advanced font rendering. Thanks to its underlying Quartz technology, Mac OS X makes text beautiful and easy to read on all displays. It also provides resolution-independent font handling, anti-aliasing, and special anti-aliasing algorithms for LCD screens. A setting in the Appearance system preference lets you select one of five font-smoothing styles to increase onscreen readability: Automatic (best for main display), Standard (best for CRT), Light, Medium (best for flat panel), and Strong. Sophisticated font-rendering technology with subpixel positioning also automatically increases the effective resolution of the font on the display you are using. Mac OS X eliminates the need for ATM Light because the built-in font rasterizer works for all font formats, including PostScript and OpenType.

Professional typography. Sophisticated typographic capabilities such as kerning and tracking are no longer limited to professional layout applications. Font technologies in Mac OS X are supported at the system level, so even basic applications such as TextEdit can take advantage of advanced typographical features, including variant glyphs.

Variant glyphs can be a single character or a series of characters (a ligature). The "pf" is a ligature, and the entire font name Zapfino is a single glyph. Notice the different letterforms—how the "p" changes when followed by "f," and how each of the letterforms changes in the final glyph.
Working with Fonts in Tiger

Mac OS X Tiger offers a number of ways to manage and work with fonts. Font Book, the Font panel, and the Character Palette make it easy to access and manipulate fonts in your Mac OS X applications. You can use these tools to work with your fonts in a consistent manner from program to program.

Font Book

Font Book provides a window into all of your fonts, regardless of whether they’re installed in your private directory, shared with all users of a particular Mac, or shared with everyone on the network. No matter where a font is placed on your system or who can access it, you can view and manage it from a single, central location.

Font Book lets you easily install and preview fonts; search through them; create font collections; and disable, enable, and remove fonts. For example, you can use Font Book to customize the fonts that are accessible to all Mac OS X applications, giving you quick access to the fonts you need while not cluttering the Font menu with the ones you don’t.

Managing fonts with Font Book is similar to managing songs with iTunes. You can create collections of fonts (similar to iTunes playlists), and then use the collections to access the fonts you need at any given time.

You can use Font Book by itself for your day-to-day font needs, or in conjunction with a third-party font manager. Because Font Book is a separate application rather than part of the operating system, it is an excellent complement to third-party font managers.
Font Panel

The Font panel in Tiger lets you access fonts from a number of Mac OS X applications—including Mail, TextEdit, and Keynote. You can use the Font panel to preview fonts, create font collections for specific clients or jobs, and add fonts to a favorites menu. Any action you take in the Font panel is reflected in Font Book to ensure consistency and save time. The Font panel also lets Mac OS X software developers incorporate a standard font selection interface into their applications.

1. The Font panel provides a preview of a font at a particular size.
2. Installed fonts can be grouped in a collection for easier selection. Changes made to collections in the Font panel are reflected in Font Book.
3. Fonts can be sized by entering a value, clicking a size in the list, or using the adjustable slider.
4. The Action pop-up menu in the Font panel provides access to the Typography panel, the Character Palette, and other features.
The Typography panel allows you to tailor fonts so they are exactly right for the project at hand. Controllable features include ligatures, style variations, kerning, number spacing, fraction rendering, swashes, number and letter case, and more.

You access the Typography panel from the Action menu in the lower-left corner of the Font panel in an application. The Typography panel changes depending on the font you’ve selected in the Font panel.

The following are two examples of how fonts can be modified using the Typography panel.

Stylistic control
This screen shows the Typography panel for the Hoefler Text font included with Mac OS X Tiger. It’s one of several fonts with an extensive array of options that you can set on a character-by-character basis.

An example of glyph variations in the Zapfino font.

An example of capital letter variations in the Papyrus font.
Character Palette

The Character Palette makes it easy to locate a specific character or symbol on your system, preview it, and select among its different variations—across all the active fonts on your system. In addition to providing a view of characters by font (similar to the preview capability in Font Book), the Character Palette lets you view individual characters grouped in various categories.

See the “Character variations” sidebar for one use of the Character Palette.

Keyboard Viewer

Fans of the Key Caps utility in Mac OS 9 will want to try the Keyboard Viewer in Mac OS X (System Preferences > International pane > Input Menu). This handy palette lets you view the way the keys on your keyboard map to the characters in each font.

If you need to operate your Mac in a different language but do not have an international keyboard, the Keyboard Viewer makes it easy to enter the characters you need. The Keyboard Viewer changes its character key layout to match the language you’ve selected.

The Character Palette provides access to individual glyphs.

1. Choose from several view options.
2. View Roman fonts by category or by favorites.
3. Add a favorite glyph with one click.
4. Once you’ve selected a glyph, insert it into your document by double-clicking it, dragging it from the well, or clicking the Insert button.
5. Choose the font you want to search or limit your options to just the fonts that contain the glyph you want.
6. See a preview of the glyph and the glyph’s name.
You can access the Character Palette in three ways:

- **Special Characters.** You can display this palette by selecting Special Characters from the Edit menu in many Tiger applications.

- **International menu.** If you have enabled the Input menu in the International pane of System Preferences, you'll see the Character Palette under the flag icon in the Mac OS X menu bar. You can select an International keyboard by choosing the flag icon for the country whose keyboard layout you wish to use.

- **Font panel menu.** You can view the palette by selecting Characters from the Action menu in the lower-left corner of the Font panel.
Mac OS X Tiger lets you install, organize, find, and access fonts with unprecedented control and ease. Whether you want to validate fonts before or after you install them, store fonts on a central server, activate and deactivate groups of fonts with a click of the mouse, or organize fonts for a third-party font manager, Mac OS X has the tools you need—already built in.

Mac OS X offers broad support for a variety of font formats, so it can manage virtually any type of font you have in your creative arsenal.

Here are a few general guidelines for installing your fonts in Tiger, depending on what type of font you’re using.

For PostScript fonts, you will need to install both the screen (FFIL) files and the printer (LWFN) files that correspond to each typeface to make everything display and print correctly on your Mac OS X system. If you copy files from a CD that has both Macintosh and Windows versions of PostScript fonts, be sure to use the Macintosh versions.

Mac OS X also supports Multiple Master fonts, a special type of PostScript font. As with other PostScript fonts, you will need to install both screen and printer files.

TrueType fonts have all the information they need for both onscreen display and printing in a single file, so you need to install only one file for each TrueType font. Note that Mac OS X can use both Windows and Macintosh TrueType fonts, but with Windows versions you need to copy only the main TrueType font file. You don’t need to install the Windows AFM file.

OpenType PostScript fonts and Mac OS X offer the benefit of letting you use an expanded number of characters. In addition to eliminating character limits, Mac OS X does not require you to use Expert typefaces as you did in previous Macintosh operating systems. When installing an OpenType font, you need to copy only one file for each typeface, because the file contains everything needed for both screen display and printing.

The new Font Validation feature in Tiger lets you validate any type of font during installation to prevent the addition of a problem font. With a full report of every validated font, you can easily see which fonts have passed the validation test and which require further attention, and select only the safe fonts to install. Font Validation works for both new and already installed fonts, and is very helpful for uncovering problem fonts that should be removed or uninstalled.

Also new to Mac OS X Tiger is the export feature. Now you can export licensed fonts in the form of a font folder and install them on another computer. This feature is particularly useful when you are collaborating on a project as part of a team to ensure that everyone is using the same font.
Once you’ve installed the proper fonts on your computer, Font Book, powered by the new Spotlight technology in Mac OS X Tiger, lets you search for a rich set of font attributes, including font name, copyright, languages, styles, and more.

Mac OS X Font Locations

Mac OS X is a versatile, multiuser operating system—a major benefit in creative environments. To maximize creative options and workflow productivity, you can set up one system exactly how you like it, and configure the same system to suit the preferences of other users such as freelance designers.

This versatility also goes for fonts, which can be stored so they’re available to a specified user, to all users of a certain Mac, or to everyone on a network. You can control which fonts are used for a specific job or client, and which users have access to each font. Hierarchical font folders allow you to create multiple levels of font folders within font directories for even better organization.

No matter where you’ve installed fonts, Tiger immediately recognizes and activates fonts installed in any of the font folder locations, including subfolders. (See Appendix D for details on active font locations.) If you activate or deactivate fonts frequently, it’s best to use the built-in Font Book application or one of the third-party font management applications available for Mac OS X. Keep in mind that while you can use individual folders to install fonts, Font Book is your preferred option because it lets you easily install fonts and make them accessible from a central location instead of having to copy them to individual folders.

Home directories

If you are the only person who uses your Mac, then making your fonts accessible to your home directory is your top priority. This directory is where you go when you click the house icon in a Mac OS X Finder window. If you would like to install fonts that only you are going to use, drag them into the ~/Library/Fonts folder. This location will make the fonts accessible when you are working in your home directory. See Appendix D (“Font Locations in Mac OS X”) for more information on where to install fonts.

Fonts installed by applications

Some applications come with fonts and automatically install them in the /Library/Application Support folders. Unless you move them, these fonts will be accessible only to those individual programs. Making these fonts accessible to all of your applications is simple. Just drag them in the Finder to systemwide or user font folders such as /Library/Fonts or /Users/<your user name>/Library/Fonts (also referred to as ~/Library/Fonts).

Note that Adobe Creative Suite uses some fonts to generate dialogs and help menus. It installs these fonts in a folder called Reqrd in /Library/Application Support/Adobe/Fonts. Do not move these fonts to a different folder.

Other applications may install special fonts in one of the Mac OS X font folders instead of in their own folders. To simplify font management, you might want to use Font Book to make a collection of each application’s fonts. This strategy will allow you to deactivate the fonts and create “clean” font lists in the system font folders.

Some applications, such as Microsoft Word, update their font menus only at application launch. You’ll need to quit and restart these applications after activating or deactivating fonts. It isn’t necessary to quit and restart applications such as Adobe InDesign CS that automatically recognize font changes.

To find out if you need to restart an application, check its Font menu immediately after you add a new font. If the font doesn’t show up, simply quit and relaunch the application.
Classic Fonts and Native Applications

If you work with Classic applications, you’ll find that Mac OS X offers a number of features that improve on the font management capabilities that were available to you in Mac OS 9. Because you are essentially running two different operating systems side by side—Mac OS 9 and Mac OS X—you should know about several important font issues.

Font smoothing

With built-in anti-aliasing technology for font smoothing onscreen, Mac OS X eliminates the need to use extra applications such as ATM Light. However, if you use Classic applications with PostScript fonts, you’ll need to install ATM Light version 4.6.2 or later (a free download from Adobe at www.adobe.com/support/downloads). If you use Adobe Photoshop in Classic, you don’t need ATM Light, because Photoshop 5.5 and later versions handle their own font rendering.

Font folder priorities

Mac OS X uses font folder priorities to determine which fonts to use. For example, if you have a PostScript version of Helvetica installed in the Classic Fonts folder (<startup volume>/System Folder/Fonts), it will work fine for Classic applications. But for Mac OS X applications, the system will use the Helvetica font located in /System/Library/Fonts—a higher-priority folder for Mac OS X. As a result, you could wind up using two different versions of Helvetica if you are using both QuarkXPress in Classic and Adobe Illustrator in Mac OS X, for example. If you have a project that will be used in both Classic and Mac OS X environments, and you would like a font to be consistent across both environments, place the font you want to use in the Classic Fonts folder.

To avoid any problems, be sure there are no font name duplicates between fonts in your Classic Fonts folder and fonts in higher-priority folders such as /System/Library/Fonts. (See Appendix D for information about folder priorities.)

Some applications in Mac OS X may require Helvetica to display text. If you are in a production environment and you use a specific Helvetica font, you can remove the version of Helvetica that ships with Mac OS X and replace it with yours. If you need to change the version of Helvetica in use on a job-by-job basis, keep in mind that you may need to activate the version of Helvetica that comes with Mac OS X for some applications to function correctly. If you have both Classic and Mac OS X versions of a font and you choose the Classic font (the one stored in <Classic System Folder>/Fonts) as the one to keep, that font will continue to work in both Mac OS X and Classic. If you select a version outside the Mac OS 9 System Folder (such as /Library/Fonts), that font will no longer be available to Classic applications. Apple recommends that you keep the version of Helvetica shipped with Mac OS X in the system library.

Legacy font suitcases—moving fonts from Mac OS 9 to Mac OS X

Tiger lets you use all your favorite legacy fonts, including those that started as a font suitcase in Mac OS 9 or were custom built. If you’ve brought a font suitcase into Mac OS X, the file might contain both TrueType and bitmapped versions of the same font. Mac OS X will open and use both fonts, creating potential conflicts.

The best way to prevent this problem is to extract all screen fonts from the suitcase and then install the specific fonts you need using Font Book or your third-party font manager. You can open the suitcase in a Finder window on a Mac that has been started up in Mac OS 9 or earlier and extract the fonts, or you can find and install a copy of Font/DA Mover 4.1 and run it in the Classic environment of Mac OS X to disassemble the suitcase.

See Appendix A for information about products that can help resolve suitcase issues.
Server-Based Fonts

By creating a central font location on a local or network computer, you can make fonts available to multiple Mac users quickly and easily. What's more, you'll be certain that everyone involved with a specific project—from initial design to final printout—is using the same version of each font, no matter which Mac they're using. Having a central font location can also reduce system administration efforts.

To store fonts centrally, mount the server volume on the local computer and point your font manager at the fonts in that location to open them. Make sure that your network can handle the extra font-sharing traffic. A 100BASE-T switched network or better is recommended for font servers and clients.

Sharing fonts on the network

If you have a system with Mac OS X Server version 10.3 or later, you can—with the proper licenses—set up fonts to be shared easily by multiple computers.

Follow these steps:

1. Install the fonts in a folder called Library/Fonts on the system running Mac OS X Server.
2. Open Workgroup Manager and click Sharing.
3. Click Share Points and select the folder that contains the fonts.
4. Click Network Mount.
5. From the Where pop-up menu, choose the directory domain that contains your users and computers. If the correct directory is already selected, click the lock to authenticate.
6. Choose the sharing protocol (AFP or NFS) from the Protocol pop-up menu.
7. For the “Use for” setting, select Shared Library to share your Fonts folder under /Network/Library.
8. Click Save.

For more information, see the Mac OS X Server File Services Administration Guide.

You can also use third-party software to automatically activate and manage version numbers and client-specific fonts. These products usually have a server-based software application; you can then add clients as necessary.

Managing Fonts with Font Book

Tiger lets you use all of your fonts and manage them from a central location—the Font Book application. While you can install fonts in individual folders, Font Book offers easier installation and management from a central location.

No matter where you store your fonts, Font Book can see and install them. Font Book can install fonts in a location from which both Classic and Mac OS X applications can access them. You can also use Font Book to create font sets—called “collections”—for specific tasks or software applications, simplifying font management. For Mac OS X, Font Book can activate and deactivate fonts or collections as needed. In design and publishing environments, where users frequently need to switch between sets of fonts, Font Book makes it easy to prepare a base font system and then manage specific fonts for each job.
If you're a designer who deals with dozens of fonts, creating collections is the ideal way to organize your font libraries. Here are some ways you can use collections to manage large libraries.

- **By client.** Many clients require a specific set of fonts for all of their projects. Creating a collection makes it easier to reenable the fonts you need when working on these projects.

- **By project name.** Create a collection of fonts that you plan to use for a particular project, so you see only the fonts you need.

- **Alphabetically.** Organize fonts in alphabetical groups, such as A–D, E–H, and so on. This is the simplest method of organization, and it allows for fast navigation when searching for a font name.

Font Book lets you create any number of collections, making it easier than ever to organize your fonts and activate specific sets when you need them. Individual font families can be placed in multiple collections.

If you manage fonts from many different sources, you will need to use Font Book in a very specific manner. See the discussion of prepress and production font management in the “Font Management for Prepress and Production” section on page 25 for more information. Also see Appendix A for information about third-party font utilities.

### Setting Font Book preferences

Font Book displays all the fonts currently installed on your Mac and makes it easy to install additional fonts. When you use Font Book to install a font, it offers a number of options. Here's how to set your preferences.

Begin by choosing Preferences from the Font Book menu.

The Preferences window has been simplified to two options: selecting an installation location for your fonts and choosing your validation preference. The installation location determines who will be able to access the installed fonts. Font Book then installs the fonts in the proper folder for your chosen access privileges. From the pop-up menu, select the location where you want your fonts installed.

Font Book identifies duplicate, malformed, or corrupt fonts using the new Font Validation feature. This feature is particularly useful for preventing the installation of fonts that might cause problems with your system. If you want Font Validation to run automatically each time you install new fonts, check the Validate box.

You can now close the Preferences window.
Installing fonts with Font Book

Once you've set your Font Book preferences, you're ready to begin installing fonts. You can add fonts to Font Book in two ways: by selecting the fonts in the Finder or by dragging them into Font Book. With both options, fonts are automatically activated once they're installed. You can later disable a specific font or typeface, allowing you to control which fonts are active for a particular job without having to physically remove the ones you don't need.

When installing fonts in Font Book, the best method is to start with your original font sources—typically CDs or DVDs—and add the fonts to Font Book using the All Fonts menu. If you have graphics applications that you still use in Classic, it’s best to add all of your fonts to the Classic location. If you have only Mac OS X applications, then either choose Computer to make the fonts available to all users of that computer, or choose User to make the fonts available only to the current user. Starting from the original source of the fonts will reduce the number of duplicate fonts and the risk of installing damaged fonts. To further protect against installing damaged fonts, see the “Validating fonts” section that follows.

Selecting fonts in the Finder

To add a font to Font Book from the Finder, begin by viewing your available fonts in a Finder window. Double-click the font you want to add. Font Book then displays a preview of the font. A pop-up menu above the font sample indicates the available styles for that font.

PostScript fonts have both screen files (1) and printer files (2), whose file types appear in the icon. Click either file to activate the font.
To install the selected font, click Install Font.

Drag and dropping
Adding fonts from the Finder is an easy way to install a new collection. You can drag a folder containing fonts into the Collection list in Font Book.

When you drag one folder to the list, the new collection maintains the name of the top-level directory. Fonts installed in this manner are always installed in the preferred installation location. For example, if you drag a folder for WarnockPro into the Collection list, you will see a new font set in Font Book called WarnockPro.

If you drag two or more folders, Font Book combines the directories into one set and assigns a new name. Note that creating collections by dragging folders from the Finder rather than selecting fonts from the font list might result in adding duplicate fonts to Font Book. (See the “Duplicate fonts” section on page 20 for tips on how to handle this situation.)

Using this method only installs the font; it does not create a collection. You can then create a collection and add the font to it.

Validating fonts
Font Book has a new feature called Font Validation that you can use during the installation process, or even after a font is installed, to identify fonts that might cause problems displaying or printing documents when you use them with your applications and the operating system. By default, Font Book validates a font when it is installed.

Each font file consists of a series of attributes that the system needs to display and print the font. To determine whether a font is valid, Font Book checks the font files to make sure that these attributes are correctly formatted. After Font Book validates the font, a pane displays the results. Depending on what is found, you will see one of the following results for each font:

- **Passed.** The font is safe to use and can be installed without problems.
- **Minor problems.** This result means certain items have been found in the font that may affect its behavior. While you can still use this font, you may experience unexpected results.
- **Serious problems.** You should not install this font. Contact the original font vendor to obtain a properly formatted font. If you need to send an error report to the vendor, you can create one by selecting Save Report from the File menu.

If the font passes validation, you can check the box next to the font to enable the Install button and continue the installation.
**Previewing fonts**

Once a font is installed, you can preview it in different ways from the Preview menu in Font Book:

- **Sample.** Shows the font using a standard alphabetical list of characters.
- **Repertoire.** Shows the entire list of characters available in the font.
- **Custom.** Shows what a custom string of text looks like in the font. This option allows you to type in the preview window.

In all font preview modes, you can zoom in and out to view a font in a wide range of sizes.

There are three ways to view the selected font: custom, repertoire, and sample.

**Searching for fonts**

In Mac OS X Tiger, you can now search more specific font attributes to find exactly what you’re looking for, even with a library of thousands of fonts. Font Book lets you search by font name, PostScript name, and family name separately. You can search by language, kind, and other attributes of a font. Searching by the copyright name is useful if you want to find the fonts from a particular company, such as Adobe or ITC. In the example below, a search for Bold shows only those families and typefaces with fonts that are bold.

![Sample, Repertoire, and Custom previews of a font in Font Book.](image-url)
Building and managing Font Book collections
Once you have installed all of your fonts, you’re ready to get organized and save time by making font collections. Mac OS X provides several collections to get you started.

All Fonts collection
The default collection of fonts on your system is All Fonts. This collection shows all the fonts that Font Book can control on your computer, whether they’re installed in your private directory, shared with all users of your Mac, or shared with everyone on the network. This collection is special because it displays fonts no matter where they are stored on your system or who can access them.

- **User.** These fonts are installed in a user’s /Library/Fonts folder. They are available only to that user.
- **Computer.** These fonts are installed in either /System/Library/Fonts or /Library/Fonts. They are shared with all users of the Mac.
- **Network.** If you are on a network with a server that shares fonts, then these fonts appear in the All Fonts collection.

Note that Font Book is designed to manage fonts that are in approved Mac OS X system locations or in user-created font libraries. It does not affect application-specific fonts.

Creating System and Master Font Book collections
As a design or print professional, you probably need to add, delete, activate, and deactivate fonts frequently for different clients or projects. Sometimes you might also want to deactivate some of your installed fonts and use other font formats from previous projects or for print specifications.

When you turn fonts on and off, you need to ensure that you do not deactivate fonts that Mac OS X requires for proper operation and user interface display. Use Font Book to copy the All Fonts collection and divide the copy into two new sets: one that will be protected from deactivation—System fonts; and another for all your other fonts—Master fonts. Alternatively, if you prefer to place your favorite fonts in your user fonts folder (~/Library/Fonts), you don’t need to add the fonts to the All Fonts collection. Mac OS X automatically places fonts in the All Fonts folder if you’ve added them to your user fonts folder.
Creating a System font set

Your System font collection contains all the fonts that Mac OS X needs for dialogs, basic text input, and international language support. Some applications might not function properly if the System font set is disabled or deleted. For this reason, you need to create a protected collection of these fonts to ensure that they can never be disabled.

To create a System set:

1. Click the Add (+) button below the Collection column.
2. Type System for the name of the set, then press Return.
3. Select All Fonts in the Collection list.
4. Drag the following fonts from All Fonts to System:
   - Geneva
   - Helvetica
   - Lucida Grande
   - Monaco

Keyboard and LastResort fonts

If you view your fonts in a Finder window rather than in Font Book, you might see the fonts Keyboard and LastResort. They are located in the System folder and are vital if there is ever a problem with your managed fonts. They will not affect your print jobs or show up in your applications. Never delete Keyboard or LastResort.

Creating a Master Fonts set

Now that you’ve created a System Font Book collection to protect certain fonts from deactivation, you can gather all of your favorite fonts into Master Fonts, your base font collection. The Master Fonts collection gives you easy access to your fonts. It can also play an important role when you need to add fonts for a certain job or check that all the fonts you need for the job are available. If you create a new collection containing job-specific fonts, you can disable your Master Fonts and then view the document for the current project—Mac OS X alerts you to any missing fonts. You can then go back and add the necessary fonts to the job-specific collection.

Here’s how to create a Master Fonts set in Font Book:

1. Click the Add (+) button below the Collection column.
2. Type Master Fonts and press Return.
3. Select All Fonts in the Collection list and press Command-A to select all the fonts.
4. Drag the fonts to Master Fonts. You have now duplicated your All Fonts collection.
5. Remove the following fonts from the Master Fonts list by selecting them and choosing Remove Font from the File menu:
   - Lucida Grande
   - Monaco
   - Charcoal (if you will be using Classic applications)

(Note: If you see two versions of any of these fonts, remove both copies.)

Remember that this action removes only the fonts from the current collection, not from Font Book or your system.

Following these instructions will ensure the proper functioning of Mac OS X as well as Apple applications such as Mail, Safari, iCal, and Address Book. However, some third-party applications might require other system fonts to display documents or draw dialogs. Always be cautious when deactivating system fonts, and be prepared to reactivate them if you encounter any application problems.
You can build additional collections over time as needed for particular jobs. After a job is completed, you can delete the job’s collection, or save it if you think you’ll need it again in the future.

**Enabling and disabling fonts**

When you add a new font to Font Book, Tiger automatically activates it. In Font Book, you can easily enable or disable individual fonts as you need them. You can enable and disable individual fonts or collections of fonts to specify which ones are currently available to applications. This capability is especially useful when you have many fonts installed, including multiple versions of the same font families. If you’re familiar with the concept of font activation in other font management applications, Font Book works in essentially the same way.

- Font Book allows you to shorten the list of fonts to only those you want to use. For example, if you want to enable only fonts of a particular language, you can select fonts from other languages and disable them.
- Some projects require specific versions of font families. For example, if more than one version of Helvetica is installed, Font Book allows you to enable the exact version you want to use.
- Font Book enables and disables fonts dynamically, allowing you to switch between font sets without restarting applications.

With AppleScript and Automator support in Tiger, you can automate the process of enabling and disabling fonts from anywhere in the system.

To disable a font or an entire collection, select it in Font Book and click the Disable button at the bottom of the window. To reactivate a font or a collection, select the item and click the Enable button at the bottom of the window. Font Book toggles the button’s label between Disable and Enable as appropriate. Disabled fonts are marked “Off” next to their names.

**Font Book and Classic applications**

Font Book is designed to manage fonts for Mac OS X applications, so activating and deactivating fonts in Font Book does not affect the fonts you use in Classic applications. Any font in the Fonts folder of your Classic System Folder always appears in the font lists of your Classic applications, even if you have disabled it in Font Book.

If you want to use a single application to manage fonts for both Classic and Mac OS X applications, consider a third-party font manager.

**Duplicate fonts**

Font Book displays fonts stored in all the hierarchical font folders in Mac OS X. When two or more copies of a font have the same name, Font Book marks the duplicates with a dot. The one without the dot is the active font.

For convenience, Font Book can fix duplication problems for you. Simply select the fonts, then choose Resolve Duplicates from the Edit menu. Font Book determines the active font and deactivates all the duplicate copies.

To resolve duplicate fonts of a specific typeface, select that typeface, then choose Resolve Duplicates. All duplicates of the typeface will be disabled.

If you do not use Font Book to resolve or remove duplicates, the locations of the different copies in the Mac OS X system hierarchy determine which font is used. If there is a conflict at the top of the hierarchy of your system, the system makes an arbitrary choice to resolve the duplicate. If you have job-specific fonts, you should select the font you need by activating it in other locations. See Appendix D for more information about the font usage hierarchy in Mac OS X.
Alternatively, you can resolve duplicate fonts manually. To do this, click the specific font you want to keep, then choose Edit > Resolve Duplicates. The font you selected remains activated, and all of the duplicates are deactivated. You can also disable a specific version of a font by using the Disable button.

Each duplicate font is shown in every set. To help you tell the fonts apart when you’re choosing which one to activate, position your cursor over one of them in the list. A yellow "tool tip" displays detailed information about the font, including its location.

If you have both Classic and Mac OS X versions of a font and you choose the Classic font (the one stored in <Classic System Folder>/Fonts) as the one to keep, that font will continue to work in both Mac OS X and Classic. If you select a version outside of the Mac OS 9 System Folder (such as /Library/Fonts), that font will no longer be available to Classic applications.

Organizing Fonts for a Third-Party Font Manager

You can organize fonts for a font manager application in many ways. However, most creative professionals follow the same basic strategies and organizational structures.

Members of creative workgroups who do not have a fast internal network or access to a central file server might prefer to manage fonts locally on their individual computers. If you have a fairly robust network and a central location for application files, however, it is best to centralize your fonts on a server. See page 13 for more information about server-based fonts.

You can organize fonts on local drives in several ways: by client, by job, and by name. In addition, some third-party font managers offer special locations for font storage, but you might not have to use that location. Check with the company that provides the font manager application.

Here are a few best practices used in the industry.

- **Organizing fonts by client.** This option is useful in design shops with many clients, where each client has a specific identity package.

- **Organizing fonts by job.** This option is especially useful in service bureaus.

- **Organizing fonts by name.** This is a good option for design shops that regularly use an assortment of fonts.
Optimizing a Production System

Depending on your workflow requirements, you might find it helpful to optimize font organization on your Macintosh workstations. This section describes how to deal with nonessential fonts either temporarily or permanently, and addresses some of the special font management needs of service bureaus.

Removing or Deactivating Nonessential Fonts
In Mac OS X, as in Mac OS 9, fonts located in system-recognized font folders are always on and available to applications, unless you have used a font manager to override or deactivate them. To prepare your system for the strict font requirements of design and production, you might want to remove or deactivate some of the preinstalled fonts in Mac OS X that will conflict with versions or formats of the fonts you use in your workflow. You might also wish to remove or deactivate fonts that you do not plan to use, so that they will not show up in your font lists.

Using Font Book, you can deactivate fonts and leave them in place rather than remove them entirely. If you plan to use a third-party tool to manage your fonts, it’s advisable to remove nonessential fonts from the system locations so that those fonts are not accidentally activated. Note that some of the preinstalled Mac OS X fonts have additional characters you might want to use, such as foreign language characters. You can use the Character Palette to browse the glyphs of a font (choose Glyph from the View pop-up menu) before deciding whether to remove it.

When choosing which fonts you want to keep and which you want to remove, be careful not to delete fonts that are required by Mac OS X or the Classic environment.

Production tip
If you are a system administrator, you will want to retrieve and maintain a “clean” set of fonts from original CDs. Or you can use products such as FontDoctor or TransType to create a clean set of fonts for consistent, predictable deployment to users.

Removing required fonts might prevent your Mac from starting up or cause application problems. Required fonts are listed in the sections that follow.

You can remove nonessential fonts manually in the Finder by dragging them to the Trash. If you attempt to remove a font from the System at /Library/Fonts, you will be asked to authenticate your ID with an administrator’s login and password.

To remove fonts using Font Book, follow these steps.

Removing or deactivating fonts in Classic
The fonts in the System Folder in Classic support applications that run in the Mac OS 9 Classic environment. However, all applications, including Mac OS X applications, can access these fonts. You might therefore have duplicate fonts—those that Classic uses and those that Mac OS X uses. Follow the steps that follow to remove fonts with names that conflict with fonts you’re going to be using in production.
1 Open Font Book.

2 Click the triangle next to All Fonts.

3 Select Classic Mac OS. This option shows the Fonts folder in your Classic System Folder.

4 Select the fonts you wish to remove. To select multiple fonts that are contiguous in the list, use Shift-click. To select noncontiguous fonts, use Command-click.

5 Now choose either Remove Font from the File menu or Disable Font from the Edit menu.

   The following Classic fonts are commonly removed or disabled:
   - Courier
   - Helvetica
   - New York
   - Symbol
   - Times
   - Zapf Dingbats

   Do not remove these fonts:
   - Charcoal
   - Chicago
   - Geneva
   - Monaco

   Removing or disabling these fonts might cause some of your Classic applications to work improperly.

Deleted fonts are now in the Trash. If you prefer, you can remove the fonts from the Trash and place them in a folder in case you want to add them back at a later time. Store the fonts in a safe place, such as a new folder named “Fonts Removed from Classic” in your home folder or in the /Users/Shared folder.
Removing or deactivating fonts in Mac OS X

Font Book makes it easy to remove fonts from the Mac OS X system, regardless of where the fonts reside.

1 Open Font Book.
2 Click the triangle next to All Fonts.
3 Select Computer. This option shows the fonts from two physical locations on your hard drive: /System/Library/Fonts (requires administrator access) and <startup volume>/Library/Fonts. This is the place for fonts that you want to make available to all users of the computer.
4 Select the fonts you wish to remove. To select multiple fonts that are contiguous in the list, use Shift-click. To select noncontiguous fonts, use Command-click.
5 Now choose either Remove Font from the File menu or Disable Font from the Edit menu.

The following fonts are commonly removed:
- Courier
- Futura
- GillSans
- Helvetica
- Helvetica Neue
- Times New Roman

These fonts are usually replaced with your preferred version by using Font Book or a third-party font manager. You can also remove the various foreign language fonts if the system is going to be used only with Roman languages. If you are using a localized system, you might also need some specific system fonts for that language.

Several system fonts are essential. Never remove them. Doing so will prevent the system from starting up and will likely require reinstallation of the operating system. They are:
- Geneva
- Helvetica*
- Lucida Grande
- Monaco

* For optimal performance, leave the version of Helvetica that shipped with the system. However, you can replace it with another version if necessary. In doing so, some application layouts may be affected.

If you remove these fonts, some of your applications might not display text correctly.

If you selected any fonts for removal that were in the /System/Library/Fonts folder, you will be asked to authenticate as an administrator before the fonts are moved to the Trash. You will not be asked to authenticate if you are simply disabling the font.

The deleted fonts are now in the Trash. If you prefer, you can remove the fonts from the Trash and place them in a folder in case you want to add them back at a later time. Store the fonts in a safe place, such as a new folder named “Fonts Removed from Mac OS X” in your home folder or in the /Users/Shared folder.

Keeping a version of Helvetica

A few Mac OS X applications require an active version of Helvetica. The most common symptom that indicates Helvetica is missing is an application that does not display windows or type that does not display correctly. Corrupt fonts can also cause incorrect type display. (See Appendix A, “Additional Resources,” for more information on this topic.)

If you regularly use any applications that require Helvetica, be sure to follow this tip: As soon as you remove Helvetica from the system, install another version of Helvetica with your font manager of choice. The font format you use—TrueType, OpenType, or PostScript—doesn’t matter, as long as one version of Helvetica is present.
Removing or deactivating fonts on international systems
In addition to the fonts discussed previously that are required for any Mac OS X system (Lucida Grande, Monaco, Keyboard, and LastResort), each international version of Mac OS X requires specific fonts for proper operation.

You can determine which fonts are system fonts by looking in /System/Library/Fonts. The fonts that must not be removed are listed below. They are also marked with a lock icon when you view them with Font Book. Apple recommends that you leave all of these fonts in place even if you do not plan to use all of the listed languages, because you never know who might use your system or how it might be used in the future.

Required Japanese fonts:
• Hiragino Kaku Gothic Pro W3 and W6
• Hiragino Mincho Pro
• AquaKana
• Osaka and Osaka Mono (needed for application compatibility)

Required Traditional Chinese fonts:
• LiHei Pro
• Apple LiGothic Medium (needed for application compatibility)
• Hei (needed for application compatibility)

Required Simplified Chinese fonts:
• STXiHei
• STHeiti

Required Korean font:
• AppleGothic Regular

Required Arabic fonts:
• Geeza Pro Regular and Bold

Font Management for Prepress and Production
Font Book does not create a direct link from a specific font to the collection it came from; therefore, service bureaus and other users who need to manage many duplicates and keep them linked to a set or a collection might want to use Font Book in a special manner.

If you frequently receive groups of fonts for specific jobs, it’s best to add the set, do the job, then delete the collection and the fonts associated with it before adding another set. This procedure will keep your System folder free of duplicate fonts.

• For single users who run only Mac OS X applications: Store fonts in the User collection.
• For multiple users of a single computer who run Mac OS X applications exclusively: A user with administrator rights should store fonts in the Computer collection. This approach provides a common set of fonts for all users.
• For users who run both Classic and Mac OS X applications: Place fonts in the Fonts folder in the Classic Mac OS collection.
Replacing common publishing fonts
In Mac OS X, five fonts are installed in /System/Library/Fonts that you might want to replace with your PostScript version of the fonts. Service bureaus might want to replace fonts with a customer’s version on a per-job basis using a font manager. These fonts are:
• Courier.dfont
• Helvetica.dfont
• Symbol.dfont
• Times.dfont
• Zapf Dingbats.dfont

Managing multiple versions of a font
If you have documents that use PostScript versions of a font with the same name, such as Helvetica, you will want to make sure that you use the same font for output that was used during the original design of the document rather than the dfont version that comes with Mac OS X. Otherwise, the type might flow differently or glyphs might be substituted. To ensure that the correct version of the font is used, you can perform any of the following actions:
• Activate the replacement font in Font Book.
• Create a library and activate the font from its location in the job folder. Deactivate or remove the font from other locations.
• Remove the font and replace it with your version.
• Remove the font and use a third-party font manager to open the new version of the font.
• Convert the output file to a PDF and embed all fonts.

It’s easy to verify which font is actually in use, determine the fonts necessary for printing a file, and ensure that a customer’s font versions are being used. Simply create a Master Fonts set as outlined previously, then use Font Book to create a new collection containing job-specific fonts. If you disable your Master Fonts and then view the document for the current project, Mac OS X will alert you to any missing fonts. You can add the necessary fonts to the job-specific collection.

Deleting font databases
If your fonts are garbled, or if some fonts won’t empty from the Trash even after you restart your Mac, try deleting the Mac OS X font databases.

You can do this procedure manually by removing the directory com.apple.ATS in /Library/Caches.
Appendix A: Additional Resources

Many commercial, shareware, and freeware font utilities are available. They fall into the following general categories:

• Waterfall-style viewers display “quick brown fox” or other font samples, sometimes for multiple fonts simultaneously.

• Spec sheet utilities print a list of fonts along with sample output from each selected font.

• Analysis and repair utilities locate, report, and sometimes repair damaged font files; some utilities can reorganize your fonts alphabetically or by other characteristics.

• Management (activation) utilities let you activate and deactivate fonts on demand.

• Utilities that delete font caches are helpful for troubleshooting font problems.

This appendix offers information about a number of products that provide additional functionality in working with fonts or that can solve some of the most frequent problems you might encounter with fonts.

Two good resources for font utilities are the Macintosh Products Guide (www.apple.com/guide) and Version Tracker (www.versiontracker.com).

How third-party font managers extend the capabilities of Font Book

Third-party font management products can augment and extend the capabilities of Font Book. Most popular font management products allow you to:

• Automatically activate fonts in Adobe Creative Suite, QuarkXPress, and other popular design applications.

• Keep a font set or a collection name linked to the specific font that was added to that set.

• Activate and deactivate fonts for Classic applications from the Mac OS X user interface.

• Select multiple collections at the same time and activate or deactivate them.

• Manage your fonts from a server.

• Automatically sort and categorize fonts.

• Print books of font samples.
The following applications are a few examples:

**FontAgent Pro.** Insider Software's FontAgent Pro helps you maintain font integrity, create custom font sets, and activate them when they are needed.

**Font Cache Cleaner and Font Cache Expunger.** You can use one of several utilities to automate the process of deleting font caches, including Font Cache Cleaner (www.versiontracker.com) and Font Cache Expunger (www.elara.com).

If you are using Font Book, all of your fonts will be activated after you delete the system font caches.

**FontDoctor.** FontDoctor from Morrison SoftDesign provides font problem diagnosis and repair. It includes a wide range of repair methods for damaged font tables, font ID conflicts, duplicate fonts, extra font sizes, and mixed font types.

**Font Lab.** Glyphs—usually individual letters or shapes—might appear cut off, both onscreen and in your printed output. You can use Font Lab (www.fontlab.com) to repair and resave these fonts.

**Font Reserve.** Font Reserve from Extensis gives you the ability to organize, maintain, use, and manage your fonts. It’s available in both single-user and server versions.

**Suitcase X1.** Suitcase X1 from Extensis lets you manage your fonts from a single window, while it works in the background to automatically activate fonts.

**TransType.** TransType from FontLab converts font suitcases from Windows or older file formats to Mac.
Appendix B: Mac OS X Fonts

American Typewriter: The quick brown fox jumped over the lazy dog.
American Typewriter Light: The quick brown fox jumped over the lazy dog.
**American Typewriter Bold:** The quick brown fox jumped over the lazy dog.

American Typewriter Condensed: The quick brown fox jumped over the lazy dog.
American Typewriter Condensed Light: The quick brown fox jumped over the lazy dog.
**American Typewriter Condensed Bold:** The quick brown fox jumped over the lazy dog.

Arial: The quick brown fox jumped over the lazy dog.
**Arial Italic:** The quick brown fox jumped over the lazy dog.
**Arial Bold:** The quick brown fox jumped over the lazy dog.
**Arial Bold Italic:** The quick brown fox jumped over the lazy dog.

**Arial Black:** The quick brown fox jumped over the lazy dog.
Arial Narrow: The quick brown fox jumped over the lazy dog.
**Arial Narrow Italic:** The quick brown fox jumped over the lazy dog.

**Arial Narrow Bold:** The quick brown fox jumped over the lazy dog.
**Arial Narrow Bold Italic:** The quick brown fox jumped over the lazy dog.

**Arial Rounded MT Bold:** The quick brown fox jumped over the lazy dog.
Baskerville: The quick brown fox jumped over the lazy dog.
**Baskerville Italic:** The quick brown fox jumped over the lazy dog.
Baskerville Bold: The quick brown fox jumped over the lazy dog.
**Baskerville SemiBold:** The quick brown fox jumped over the lazy dog.
**Baskerville SemiBold Italic:** The quick brown fox jumped over the lazy dog.
**Baskerville Bold Italic:** The quick brown fox jumped over the lazy dog.

Big Caslon Medium: The quick brown fox jumped over the lazy dog.
**Book Script MT Italic:** The quick brown fox jumped over the lazy dog.

**Comic Sans MS:** The quick brown fox jumped over the lazy dog.
**Comic Sans MS Bold:** The quick brown fox jumped over the lazy dog.
**Courier:** The quick brown fox jumped over the lazy dog.
**Courier New:** The quick brown fox jumped over the lazy dog.
**Courier New Bold:** The quick brown fox jumped over the lazy dog.

**Didot:** The quick brown fox jumped over the lazy dog.
**Didot Italic:** The quick brown fox jumped over the lazy dog.

Didot Bold: The quick brown fox jumped over the lazy dog.
**Futura Medium:** The quick brown fox jumped over the lazy dog.
**Futura Medium Italic:** The quick brown fox jumped over the lazy dog.

Futura Condensed: The quick brown fox jumped over the lazy dog.
**Futura Condensed Bold:** The quick brown fox jumped over the lazy dog.

Georgia: The quick brown fox jumped over the lazy dog.
**Georgia Bold:** The quick brown fox jumped over the lazy dog.
**Georgia Bold Italic:** The quick brown fox jumped over the lazy dog.
Gill Sans: The quick brown fox jumped over the lazy dog.
Gill Sans Italic: The quick brown fox jumped over the lazy dog.
Gill Sans Light: The quick brown fox jumped over the lazy dog.
Gill Sans Light Italic: The quick brown fox jumped over the lazy dog.
Gill Sans Bold: The quick brown fox jumped over the lazy dog.
Gill Sans Bold Italic: The quick brown fox jumped over the lazy dog.
Herculanum: The quick brown fox jumped over the lazy dog.
Lucida Grande: The quick brown fox jumped over the lazy dog.
Lucida Grande Bold: The quick brown fox jumped over the lazy dog.
Marker Felt Thin: The quick brown fox jumped over the lazy dog.
Marker Felt Wide: The quick brown fox jumped over the lazy dog.
Optima Regular: The quick brown fox jumped over the lazy dog.
Optima Italic: The quick brown fox jumped over the lazy dog.
Optima Bold: The quick brown fox jumped over the lazy dog.
Optima Bold Italic: The quick brown fox jumped over the lazy dog.
Optima ExtraBlack: The quick brown fox jumped over the lazy dog.
Papyrus: The quick brown fox jumped over the lazy dog.
Trebuchet MS: The quick brown fox jumped over the lazy dog.
Trebuchet MS Italic: The quick brown fox jumped over the lazy dog.
Trebuchet MS Bold: The quick brown fox jumped over the lazy dog.
Trebuchet MS Bold Italic: The quick brown fox jumped over the lazy dog.
Verdana: The quick brown fox jumped over the lazy dog.
Verdana Italic: The quick brown fox jumped over the lazy dog.
Verdana Bold: The quick brown fox jumped over the lazy dog.
Verdana Bold Italic: The quick brown fox jumped over the lazy dog.
Zapfino: The quick brown fox jumped over the lazy dog.
Appendix C: Font Support in Mac OS X

Mac OS X supports tens of thousands of fonts in many different formats. These formats are described below.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac PostScript Type 1</td>
<td>Adobe Type 1 PostScript fonts launched desktop publishing and are used today by publishers, corporations, and government agencies for high-quality output to laser printers, imagesetters, and platesetters. Each PostScript font requires two files: The screen font, or suitcase, contains the screen bitmaps and display information; the printer font, or LWFN, contains the PostScript outline, which is sent to the output device and is also shown onscreen at nonbitmap sizes.</td>
</tr>
<tr>
<td>Multiple Master</td>
<td>This special Type 1 PostScript font allows variation of one or more font parameters (such as weight and compression) to create a large number of custom styles, also known as instances. Mac OS X v10.4 can activate already created instances from a Multiple Master font.</td>
</tr>
<tr>
<td>Mac TrueType</td>
<td>Most current raster image processors (RIPs) support Mac TrueType fonts, which are typically used in home and office environments and, like Type 1 fonts, produce high-quality output to laser printers and imagesetters. A single file contains both screen and printer font information and can contain up to 65,000 different glyphs, enabling rich designs and multilingual repertoires. Advanced typographic features might also be present; they can be accessed in the Typography panel. Be sure to embed these fonts when making PDFs or PostScript files to avoid problems at the RIP. Note that applications must be revised to support Unicode through the Carbon or Cocoa APIs to take advantage of these glyph sets.</td>
</tr>
<tr>
<td>System (dfonts)</td>
<td>Introduced in Mac OS X, dfonts are no different from ordinary Mac TrueType suitcase fonts, except that they are packaged for the UNIX-style file system of Mac OS X, with the information in the data fork instead of a separate resource fork. A dfont can be converted to a Mac TrueType suitcase by moving the data to the resource fork. Third-party tools such as Resourcerer and FontLab can do this. Removing any system fonts, particularly dfonts, might reduce the number of languages that you can display.</td>
</tr>
<tr>
<td>OpenType</td>
<td>OpenType fonts (extension .otf) can contain up to 65,000 different glyphs, so type can be set in non-Roman languages such as Japanese, Chinese, and Korean. OpenType-format fonts come in two versions: PostScript-based fonts from Adobe and TrueType-based fonts from Microsoft. Mac OS X supports both outline formats. Mac OS X v10.4 supports any OpenType typographic features that are present. Adobe applications such as InDesign and Photoshop support advanced OpenType layout and typographic features such as glyph variants. Non-Adobe applications can use these same OpenType features only via the Typography panel.</td>
</tr>
</tbody>
</table>
Windows TrueType

TrueType fonts designed for use in Microsoft Windows are also supported in Mac OS X. Mac and Windows TrueType fonts share the same core format. These fonts are similar to OpenType fonts in that all the information for a typeface is stored in the data fork of a file rather than as resources in a font suitcase. The file extension for these fonts is typically .ttf (TrueType font) or .ttc (TrueType collection, which groups multiple typefaces in a single file).
Appendix D: Font Locations in Mac OS X

Mac OS X provides multiple locations for fonts for several reasons:

• Some applications, including Adobe applications such as InDesign, have their own font folders. Font Book libraries or fonts activated by third-party font management applications also reside in their own folders.

• On a computer shared by several users, one user’s fonts might not be the same as another’s, so Mac OS X provides private Fonts folders for individual users.

• Mac OS X is designed to be a multiuser system. It sometimes needs a place for shared resources such as fonts. The /Library/Fonts folder serves this purpose.

• Schools and labs might want to put fonts on a Mac running Mac OS X Server and Open Directory for everyone to share; this is the purpose of the /Network/Library/Fonts folder. (Note that fonts in /Network/Library/Fonts are always open; users can’t open and close these fonts themselves.)

• Multiple font locations with different access privileges protect critical system resources—for instance, essential system fonts needed for menus and dialogs. The /System/Library/Fonts folder lets you see these font suitcases, but you can’t easily open, move, or add to them.

• Finally, supporting Classic applications requires the use of the Fonts folder in the Classic System Folder.

When searching for a font, Mac OS X begins with the application’s font folder and proceeds in the order shown in the list that follows. Mac OS X uses the first font match it finds in this sequence. For example, if you have Helvetica in the Classic Fonts folder and Helvetica in your user Fonts folder, the latter takes precedence over the former when you are working in a Mac OS X application.

Here is a list of the places you can install fonts in Mac OS X v10.4. Any fonts that you put into subfolders of these folders are also activated.

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application’s own font folder (if it has one)</td>
<td>Some applications use their own font folder, either in the application’s folder or in the shared Application Support folder. Font Book libraries or third-party font management applications may activate fonts anywhere on your hard disk. See application documentation for more information. Note that these applications have their own methods for choosing between conflicting fonts. These methods apply in both Mac OS X and the Classic environment. (For more information on how InDesign handles conflicting font families, see <a href="http://www.adobe.com/support/techdocs/331287.html">www.adobe.com/support/techdocs/331287.html</a>.)</td>
</tr>
<tr>
<td>Your private Fonts folder</td>
<td>If you’re on a single-user system and you use only Mac OS X applications, this is the place you should put all your fonts. Only you can use these fonts. If you also use Classic applications, put your fonts in the Classic System Folder Fonts folder instead.</td>
</tr>
</tbody>
</table>

/Users/<your user name>/Library/Fonts (also referred to as ~/Library/Fonts)
<table>
<thead>
<tr>
<th>Font Collection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main font collection</td>
<td>This collection is the equivalent of the traditional Fonts folder in Mac OS 9. Fonts in this folder are available to everyone who shares a particular Mac. However, only a user with administrator access can change the contents of the folder. In a lab environment, common fonts would be placed here by the Mac system administrator. In a design or production environment without a font manager, shared fonts should be placed here.</td>
</tr>
<tr>
<td>/Library/Fonts</td>
<td></td>
</tr>
<tr>
<td>Network fonts</td>
<td>This folder is represented by the Network icon in your Computer folder, but it is located on another computer on the network. It can contain a central font collection to which Mac systems in a network can subscribe. This collection gives everyone a consistent set of fonts. All fonts in this location are always active.</td>
</tr>
<tr>
<td>/Network/Library/Fonts</td>
<td></td>
</tr>
<tr>
<td>System fonts</td>
<td>This folder contains all fonts used by Mac OS X for menus, dialogs, and icons. You can see the fonts here, but you can’t modify this folder. The “Removing or Deactivating Nonessential Fonts” section describes a method for modifying this folder and its fonts.</td>
</tr>
<tr>
<td>/System/Library/Fonts</td>
<td></td>
</tr>
<tr>
<td>Classic fonts</td>
<td>If you’re using both Classic and Mac OS X applications and you don’t use a font manager, this is the place where you should put all your fonts. This way, Classic applications can use fonts preinstalled in Mac OS X, because this is the only folder from which Classic applications can use fonts. Mac OS X applications can also use fonts in this folder.</td>
</tr>
<tr>
<td>&lt;Classic System Folder&gt;/Fonts</td>
<td></td>
</tr>
<tr>
<td>Font Book libraries</td>
<td>Font Book allows a user to define locations anywhere on the system from which to activate fonts. This method of activation is best used in production environments where it is important to control fonts used to create a job.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix E: International Language Support

Because Mac OS X takes advantage of Unicode—an international computer standard for representing the written languages of all cultures—it is not limited to Roman alphabets. With the proper fonts installed, Mac OS X could potentially support all of the world’s modern languages.

Like ASCII, Unicode is a character encoding system, but Unicode provides a unique number for every character regardless of platform, program, or language. Think of Unicode like assigned seating in a classroom: The person whose last name starts with “A” is always followed by the person whose last name starts with “B,” and they cannot change seats.

The Unicode Standard supports more than a million characters—more than enough for all the world’s languages and symbols. Historically, fonts were made up of proprietary sets of characters. Cross-platform compatibility didn’t exist. Many different encoding methods were used, often causing characters to be displayed differently in a document created on one platform and viewed on another.

The solution to these problems has come from the Unicode Consortium, a nonprofit organization that specifies how text is represented in modern software products and standards. Along with Apple, consortium members include HP, IBM, Microsoft, Oracle, SAP, Sun, Sybase, and Unisys. Today the Unicode Standard is supported in many operating systems, all modern browsers, and many other products. It represents one of the most significant advances in global software technology.

As long as an application supports Unicode, this powerful standard allows you to include characters from different languages and different alphabets in a single document or web page and deliver it over multiple platforms, languages, and countries. You do not need to install or reconfigure software to display a wide range of characters and alphabets correctly if you use the default font installation. For example, the extended font set supplied in Mac OS X supports more than 53 languages, including Baltic, Greek, Punjabi, Turkish, Cyrillic, and Simplified Chinese, and even more for display only. Mac OS X also provides one of the most complete font sets for CJK (Chinese, Japanese, and Korean) fonts—as many as 32,500 characters in the Simplified Chinese font alone.

The Unicode Standard assigns a range of numbers, or “tags,” for a character group. For example, the characters A–Z are assigned the range 65–90. Basic Greek characters are assigned the range 880–1023. In the past, Western font designers wanting to display Greek characters would simply insert the Greek “alpha” in the “a” cell, the Greek “beta” in the “b” cell, and so on. Today savvy font manufacturers use the official Unicode designation for each character. Dingbats and symbols are also used so commonly in multiple languages that the Unicode Consortium assigned these characters their own positions. In a Unicode font, familiar dingbat characters might not be accessible via the keyboard letter “n.” Access to these characters depends on whether the application manufacturer accommodates the older input method.
When you encounter a Unicode font, use the Character Palette in Mac OS X to select special characters. This type of input method is required for Symbol and Zapf Dingbats characters because they have their own encoding position; it is not necessary for other picture fonts.

For more information about Unicode, visit www.unicode.org.